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Introduction

This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.

Pages in this Section

Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening Browse
Supported Files
Preferences
Printing
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Using the Help System

This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.

If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual

 You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.
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Contacting onOne Software

 At onOne Software, we value our customers and offer a variety of ways to be contacted.

• Visit our company website at:

   www.onOnesoftware.com

• For technical support please visit: 

   www.onOnesoftware.com/support

onOne Software, Inc.

15333 SW Sequoia Parkway Suite 150 
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

© 2007­2014 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.
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Additional Help

 

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.

 

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.

 

Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

 
Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.
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System Requirements

Minimum Recommended

Operating
System

Mac OS X 10.8, 10.9, 10.10 
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit only

Mac OSX 10.9, 10.10
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit

Processor Intel Core 2 Duo, Xeon or better processor(s)
Quad-core Intel Core i5, Xeon or better
processors(s)

RAM 8 GB RAM 8+ GB RAM

Hard Drive 1 GB for installation

1 GB for installation 
Fast 7200 RPM or SSD drives
10% of boot volume should be free for
scratch disk

Display
OpenGL 2.0 compatible video card with 256 MB
dedicated video RAM, 1280x720 resolution

OpenGL 4.0 compatible video card with 1GB
dedicated video RAM, 1920x1080 resolution

Optional
Application
Integration

Photoshop CS6, CC, CC 2014 
Photoshop Elements 11, 12, 13
Photoshop Lightroom 4, 5
Apple Aperture 3.5

Photoshop CC, CC 2014 
Photoshop Elements 12, 13
Photoshop Lightroom 5 

Other
Internet connection for activation, auto update
checking, content downloads and tutorials. 

Wacom tablet for pressure sensitive input 
Hardware display calibration tool 

 

 

About Windows Video Cards

If you are using Perfect Browse from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
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Installation

To install Perfect Browse, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne Software
website or it may be on a DVD if you elected for a physical shipment.

 

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OS X

The application is installed in the Perfect Browse folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Browse is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.

Windows

The application is installed in the Perfect Browse directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Browse is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling

To uninstall Perfect Browse, follow these instructions. 

 

You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer. 

Mac OSX

1. Go to the Applications/Perfect Browse/Documentation folder.
2. Double click on the Remove Perfect Browse application.

Windows

1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Browse and then click on the Uninstall button.
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Licensing and Registration

Perfect Browse will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Browse, you will want to license it so you can
continue to use it past the trial period. When you install Perfect Browse it will prompt you to license it. Simply click on the license button and enter your license
code. Your license code can be found in your order confirmation email if you purchased the download version directly from onOne Software. If you purchased a
physical copy of Perfect Browse, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Browse on two
computers. When you enter your license code, Perfect Browse communicates with the onOne activation server and will activate your software. Your software
must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can manually
activate your software by following the manual activation instructions in the license dialog.

If you wish to move your copy of Perfect Browse from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Browse and select Deactivate from the Help menu. This will deactivate Perfect Browse on the current machine, allowing you to
install and activate it on another machine. 

If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact onOne customer service at 1-888-968-1468 or visit the support section of the onOne software website. 

It is important to register your copy of Perfect Browse if you did not purchase it directly from onOne Software, so we can provide you with the best possible
service. Registered users of Perfect Browse are eligible for free technical support, information regarding new versions and products, free updates, upgrade
pricing and special offers on new products.

Product Improvement Program

We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted. 

You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products. 

You can learn more about the Product Improvement Program here.
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Opening Browse

Perfect Browse can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OS X

1. Open your Hard Drive.
2. Navigate to the Applications folder.
3. Navigate to the Perfect Browse folder.
4. Double click on the Perfect Browse application icon.

You can add Perfect Browse to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use Launchpad
it can be found there as well.

Windows 7

1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Browse.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Browse from there.

Windows 8

1. Open the Start screen by pressing the Window key.
2. Select Perfect Browse.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Browse from there.
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Supported Files

Supported File Types

Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras
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General Settings

  

1. Working Color Space: When a new file is created or
file is opened and has no color profile associated with it,
this is the assumed color profile for the image. Images
that come from plug-ins or have tagged or embedded
profiles will use the associated profile instead.

2. Scrolling Controls: Lets you select how the mouse
scroll wheel or scrolling gesture works. The options are:

1. None: Default
2. Preview Zoom: Adjusts the zoom of the

preview window. Scrolling up increases the
zoom, scrolling down decreases the zoom. It is
important that the zooming is comfortable, not
too fast or slow or jerky.

3. Preview Pan: Pans the image, like using the
pan tool or navigator. It is important that the
panning is comfortable, not too fast or slow or
jerky.

4. Brush Size: Adjusts the size of the current tool
if relevant, such as a brush tool.

3. Preview Background Color: You may select the color
of the background behind the preview image. The default
color is black. There should be options for black, white,
light gray, dark gray and custom... The custom option a
color picker where you can select your own background
color

4. Start In: Determines which module will open
at launch. Browse is the default.  

5. Check of Updates on Launch: Enabled by default,
the product will communicate with onOne server at
launch and if an update is available it will prompt you to
download, or skip. 

6. Warn when leaving files in Layers: Enabled by
default, if you have unsaved files open in Layers and
want to close the program a warning dialog will appear
with the options to Save & Close, Cancel, or OK which will
close without saving. 

7. Language: Select which language the app user
interface is presented in. Usually this is
determined automatically but the locale of the
operating system but can be manually set.

 

 

 

Plug-ins

  

 

Preferences

 

Note: This page refers to the Preferences dialog for the Perfect Photo Suite. If you have an individual product not all of the options detailed below may
be available.

The preferences dialog contains general application settings. The preferences are accessed from the Perfect Browse menu on Mac or the Edit menu on
Windows.   

The preferences contain the following controls:
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1. Smart Photos Save PSD Files As: When you send a
PSD to Perfect Browse via a plug-in from Lightroom or
Aperture you can choose between saving the file as a
normal photo or a Smart Photo.

2. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF
(No Layers). JPEG (No Layers).

3. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences
tab, however there are only the three options supported
by Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.

4. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16-bit.

5. Resolution: Sets the resolution of copies created by
Lightroom.

6. Stack with Original: Enabled by default, copies
created by Lightroom are stacked with their original or
source image.

7. Use Original for Single PSDs: Enabled by default. If
your selection is a single PSD file, the original PSD is
opened rather than creating a copy.

  

 

Performance Settings

  

 

1. Memory Usage: Specifies the amount of system
memory (RAM) that is used by the application. The
default is 80%.

2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.

3. Process 8-bit images as 16-bit: When enabled, 8-bit
images are handled in a 16-bit space to reduce
processing artifacts. This is recommended unless you
have a computer with low memory.

  

 

Services

  

 

1. Services in Sources: Control which online storage
services are displayed in the Sources pane in Perfect
Browse.

  

12  Welcome to Perfect Browse

Perfect Browse



 

Printing
You can print your photos to your printer using
the Print function.

1. Select Print from the File menu.
2. Select your printer from the Printer pop-

up.
3. Press the Print Setup button to adjust

printer specific options such as paper size
and type and printer specific color
management options.

4. Adjust the number of copies, orientation
and output resolution.

5. In the Print Area section set the area you
would like to fill with image. This must fit
inside the paper margins. The preview on
the left shows the paper size and margins
as well as the print area and how the
image will fit or fill the print area.

6. Select the output Printer Profile and
Rendering Intent to properly adjust the
photos colors to your printer and paper
combination. You may also select the
Printer Managed Color option to let your
printer driver manage the color instead.

 

 

Tip: If you have already cropped and sized your image to your desired print area size, simply set the width and height to match in the Print Area
section. 
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Perfect Browse

Perfect Browse is a powerful and incredibly fast photo browser and manager. It gives you one place to find, view and manage
your images no matter where they are located. Browse can view the images on your computer, memory cards, external hard
drives, network shares and online storage services.

Perfect Browse isn't a database so it doesn't have to catalog your images in order to view them. Just point it anywhere and you
can view your photos. That also makes it lightning-fast. You can start to view and work with your images immediately after a
shoot without having to wait for a long cataloging or importing process. 

Some of the features:

Find your photos fast, anywhere they live:
Local drives
Network drives
Online storages services

Create a selection of images for Batch processing.
Fast browsing without the need of a catalog.
Copy, move, delete and rename files.
Sort, flag, star or color code your images.
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This getting started section will give you the basics of using the Browse Module.  You might also try watching the getting started video tutorial. For
detailed information on steps and controls mentioned in the getting started section, see the "Using the Browse Module" section instead. 

Pages in this Section
Browse Workspace

 

 

Getting Started
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Browse Workspace

The Browse Module allows easy access to your images on your computer, network or cloud based storage device while viewing a thumbnail grid or scrolling
through a larger detail view. 

 

 

 

The main window sections of Browse Module:

 A. Favorites Pane: This pane contains your favorite folders to give quick and easy access to images. 

 B. Sources Pane: This contains a list of common photo locations, including disks, favorites and cloud storage services.

 C. Filters Pane: This pane allows you to sort and search your images. 

 D. Recent Pane: This keeps track of recently opened files and folders. 

 E. Module Selector: This lists the available modules (Perfect Photo Suite only).

 F. This will display the number of files and folders you are viewing, you can use the arrow keys to move from item to item.

 G. This is your main preview window where you can view your images as thumbnails or a larger detail.

 H. Use this button to switch from thumbnail view to detail view.

 I. This slider will adjust the thumbnail size in your main preview window.

 J. This pop up will adjust your sort order.

 K. Info Pane: This section will give you detailed information about your image when available.

 L. Metadata Pane: This pane will show your metadata for your selected image. 

 M. Smart Photo History Pane: This pane will show the history of your image within the suite. (Perfect Photo Suite only)
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This section covers the complete use of the Browse Module. It includes how to navigate your folders, customize sources as well
as information on preferences and menu options.

Pages in this Section
Photo Sources
Managing Files and Folders
Favorites
Recent Pane
Working in Thumbnail View
Working in Detail View
Using the Info Pane
Metadata
Ratings, Labels and Likes
Filters
Sent to
Smart Photo History
Menus
Keyboard Shortcuts

 

 

Using Perfect Browse
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The Sources Pane is where you look for your photos. It contains a list of all disk drives, mounted server
shares and cloud storage services on your computer.

Attached Disks

Browse automatically recognizes any disk (volume) inside or attached to your computer. This includes:

Hard drives in your computer
Hard drives attached to your computer with USB, Firewire, Thunderbolt, etc.
Optical drives
USB thumb drives
Digital camera memory cards
Digital cameras, music players and smartphones that support USB Mass Storage
Network shares (mapped volumes on Windows)

Disks appear in the Sources pane with a hard drive icon next to them. Keep in mind that some disks, like
optical drives, are often read-only. You will be able to open a copy of a photo, but will be prompted to
save the image to a new location.

Cloud Storage Services

Browse supports several common cloud storage services including Dropbox, Google Drive, Microsoft
OneDrive and Apple iCloud Photo Stream. All of these services keep local copies of your images on your
computer. Browse finds and monitors these locations automatically. If you edit an image stored in one of
these locations they are automatically updated to the cloud. You can hide services you don't use in the
Preferences.

Browse automatically finds the default installation locations for these services. If you do not have
one of these services installed, or you have it installed to a non-standard location you will be asked
to install or locate the folder when you click on the source.

 

iCloud Photo Stream is a read-only source. You can open an copy of an image from it and save it to
a new location only. 

Navigating Sources

Each Source that contains sub-folders will have a disclosure triangle next to it. You can click on this
triangle or the Source name to open or "roll down" to show the first level of sub-folders inside the Source.
Sub-folders that contain folders also have disclosure triangles. This method of viewing and navigating
folders is common to both the Mac OS X and Windows operating systems. The contents of the Source or
sub-folder there of you click on will be presented in the preview area. You can also navigate folders in the
Preview area and the breadcrumbs bar above it.

 

Photo Sources
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Managing Files and Folders
You can use Perfect Browse to organize, delete and rename files and folders. This makes it a useful workflow tool for any photographer.

 Deleting a file or folder  

To delete a file or folder in the preview area, simply press
the delete key or select delete from the right-click
contextual menu.

Then confirm that you wish to move the file to the trash. If
you make a mistake you can use the undo command. If you
have multiple files and or folders selected it will move them
all to the trash. Some files or folders, like those on a
network volume must be deleted immediately and cannot be
undone.

 

 
 

 Renaming a file or folder  

 

You can rename a file or folder by selecting it, then choose Rename
from the right-click contextual menu.

If you select multiple files or folders you can batch rename them as
well. You have the option to use any combination of the current
filename, custom text and serial numbers.

 

 
 

 Creating a new folder  

 

You can create a new folder from the the right-click contextual menu in
the preview area or selecting new subfolder in the Edit menu. This will
create a new folder inside the selected folder.

 

 
 

 Copying and Moving files and folders  

You can copy and move files and folders in the ways you are
accustomed to on your computer. You can select files and folders and
use the copy command to copy them to the clipboard and then the
paste command to paste them to new location, inside or outside of
Browse. You can use this to copy a file or folder from one place to
another or to attach an image to an email for example.

You can also use the familiar drag and drop functions to copy or move
files and folders. Dragging and dropping a file or folder will move it if it
is on the same drive or copy it to another drive. You can drag and
drop into and out of the Browse module.
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 Save As  

 You can create a copy of any image using the Save As command from
the right-click contextual menu or the File menu. You can save your file
in any supported format and select it's location.

If you want to batch process multiple files use the Batch Command
instead.

 

 
 

 Show in Finder / Show in Explorer  

 You can reveal any file or folder in an operating system file window
using this command from the right-click contextual menu.
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A Favorite is a short-cut to any file path where you store your images. Several Favorites
are installed by default such as your Desktop, Pictures and the Extras folders. 

You can create your own Favorites by pressing the plus icon at the top of the Favorites
pane. An open dialog will appear where you can navigate to the folder you wish to add as
a Favorite. You can also remove a favorite by selecting it in the Favorites pane, then
pressing the minus button.

You can also add a favorite by simply dragging it into the "Drag Your Favorites Here"
hotspot at the bottom of the pane.

 

Favorites
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Recent Pane

The Recent Pane keeps track of recently opened files or manually browsed folders.  Files are listed in order
of last opened. If you have not opened any files this pane will be empty. You can quickly access your most
recent files in this pane by clicking on the one you want and it will appear in your main preview window. Keep
in mind the Recent pane only shows files you have opened directly from Perfect Browse, not files you have
sent to Perfect Browse from Lightroom, Aperture or Photoshop.

You can clear the recent file list by pressing the trash can icon.
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Working in Thumbnail View

 The Thumbnail area is the largest part of the main window and it is responsible for displaying thumbnails of folders and images you have selected using the Source and Folder Panes. 

 

 

A. Adjust the size of the thumbnails using the slider located at the bottom or use "-/+" keys on your keyboard.

B. Change the viewing mode between thumbnail and detail view.

C. When Previewing images at full screen you can quickly go to the next image by using the navigational arrows.

D. Use the breadcrumbs to quickly return to the root or click "back" to return one folder.

E. Sort the thumbnails by filename or date using the pull down menu.  The sort will always be descending, A-Z or oldest to newest.

F. Add Star Ratings and color coding to your images for easy filtering.
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Selecting Multiple Images

Select the first image and hold down on the 'shift' key and click on the last image of the group.  If the images you wish to select are not in sequential order you
can select each image individually by selecting the first image, now hold down 'Command' (Mac) or 'Control' (Windows) and select each image(s) while continuing
to hold down on the Command/Control key. 
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Working in Detail View
In Detail View you can see a full-screen version of your photo. By default when you go to Detail View, your images will be displayed in fit mode, so you can
see the entire image. However you can click on the image to zoom in to 100% or actual pixels. This is useful for judging small details and sharpness. Single-
clicking on a image that is magnified will return back to fit mode. You can click and drag a magnified image to look around. Your zoom mode is maintained as
you move from image to image so you can compare the same spot in several frames.

There is also a Navigator pane where you can reposition the preview and change the magnification amount. 

In the footer of detail view you can view and adjust the Likes, Star Ratings and Color label for the current image.

 

 

 

 Fast Preview Mode
 

 Fast Preview mode allows you to view large previews from Raw files very quickly. It does this by extracting embedded previews
from the Raw files rather than processing the full-sized image. The size of the embedded preview is controlled by the camera
manufacture. In many cases the embedded preview is the same size as the full image. In some cases it is smaller. When this
happens a small alert icon appears in the footer of detail view. If you need to zoom into 100%, press this icon to generate a full-
sized preview.

The embedded preview uses the in-camera processing. When you open the full-sized Raw file it may appear different as the Raw
processing in Perfect Browse is different than the camera manufactures. If you prefer that that the previews always match, you
can disable Fast Preview mode by press the button in the footer of detail view. 
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Navigating the Preview 
Perfect Browse provides several ways to navigate and view your image in the Preview window. 

  

The Preview Window above is the main section where you preview and work on images.

 

 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

 
Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

 

 Zoom Tool 

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

 
Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area that
is visible in the preview pane. You can pan your image by clicking and dragging inside the blue
region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%
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Using the Info Pane

 The Info Pane displays common metadata for the currently selected file.  You can view complete metadata in the Metadata Pane . This information may
include: 

Camera Make and Model
Focal Length of the Lens
Capture Date and Time 
File Type
GPS
ISO
Shutter Speed
Aperture
Exposure Compensation
Filename
Color Space
Image Dimensions and Resolution
Image Size and Bit Depth

 

 

 

 

 
If any of the metadata fields are unavailable they will be left blank. 

GPS Metadata

 If your image has GPS metadata embedded in it, the GPS button will
appear. Clicking on this button will open the default web browser to
Google Maps and navigate to the location where the image was
taken. 
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Metadata
The Metadata Pane allows you to view and add important metadata about our photo. This can include
your copyright and contact information as well as keywords and descriptions. You can also view your
camera settings (EXIF) and view and edit IPTC metadata used by journalists and stock photographers.
You can change the metadata in multiple images at the same time by selecting them all, then changing a
metadata field.

Embedding Metadata
Metadata you add in Perfect Browse is stored is industry standard XMP sidecar files for all formats. This
facilities the transfer or metadata to any application that supports XMP. When you edit and image,
create a copy of an image for editing or use the Send to command the metadata is embedded into the
file automatically (with the exception of camera RAW files). You can manually embed your metadata
into images using the embed metadata command from the Photos menu. This will open each image you
have selected, update the metadata and re-save it. This is supported for TIF, PSD, PSB and JPG files.
Camera Raw and PNG files do not support direct embedding of metadata. 
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Ratings, Labels and Likes
When you return from a shoot you have hundreds, if not thousands of images to download, sort out and cull.
This process is where many photographers spend much of their time. Perfect Browse provides the tools to

make this process efficient.

Using an industry-standard rating and label system, it is fast to sort and cull your favorites from the ordinary
and the throw-away shots. Perfect Browse offers three ways, aside from keywords and sub-folders, to mark
and group similar images. All of these methods may be set several ways including; From the Photo menu, the
right-click contextual menu, clicking the badges on the image thumbnail or in the footer of Image view. There
are also keyboard shortcuts associated with each classification option.

1. Star Ratings: Set from Zero to Five stars. Photographers often use five stars for their favorite images
and one star for images they don't want to keep. You can adjust the rating using the 1-5 keys on the
keyboard. You can also clear the stars with the ` key.

2. Color Labels: There are five color labels as well. Color labels are a great way to mark sub-sets of
images for special handling. You can set the color ratings with the 6-0 keys.

3. Likes: The most common need for photographers is to mark their favorite images and the ones they
want to delete. This is best accomplished with the Like classification. There are three clear options,
Like, Dislike and not set. You can set your Liked images with the P keyboard shortcut, your Dislikes
with the X key and clear the settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are stored in
the metadata and will be available in other photo editors and managers, like Lightroom. Likes are proprietary
and will only appear in Perfect Browse.
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Filters
The Filters pane allows you to find just the photos you are interested in your current folder. It will search for
an photos that match the criteria you set. Photos must match ALL of the set criteria to be found. To use the
Filter pane follow these steps:

1. Make sure you have the folder of images you are interested in viewing selected in
the Sources pane.

2. Turn the Filter pane on.
3. Set your filter criteria. 

Tip: The Filter pane works by filtering or searching within the current folder only. It will not show
results from other folders. It does not search all of your photos.

You can filter your photos using the following options:

Liked, disliked or not set.
Star ratings from zero to five. You can also control if you want it to show only the exact number of
stars or greater than or equal to, or less than or equal to the set number of stars.
Color Labels
Date Range. There are several preset relative date ranges or you can set your own defined date
range.
Text search. You can type into the search field to find images that contain the text in the filename,
keywords or description.

Saved Filters
You can save your filter criteria so you can use them again in the future. Perfect Browse comes with several
common saved filters that you can access from the Saved Filters: pop-up. To save your own filter criteria
just press the plus button next to the Saved Filters: pop-up. You may also delete the current saved filter by
pressing the minus button.
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Sent to
Perfect Browse lets you send images you are viewing to other applications for editing. This is done
via the Send to option, which is available from the right-click contextual menu or the Edit menu.
Perfect Browse automatically detects the following common photo managers or editors and lists the
latest installed version:

Adobe Photoshop
Adobe Photoshop Elements
Adobe Photoshop Lightroom
Apple Aperture

You can also set-up any application you want to send your photos to. Simply select
the Send to Other Application option. Then select the application you want to send
your photos to. The application will be remembered and listed with your other
Send to options. For example, if you use and email client you can add it to easily
email photos. 
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Smart Photo History

 
The Smart Photo History Pane is only available in the Perfect Photo Suite.

The Smart Photo History pane displays all of the Smart Layers inside of a Smart Photo. For each
Smart Layer it lists what modules have been applied to it.

Re-Edit a Smart Photo

1. Select the Smart Photo in Perfect Browse.
2. In the Smart Photo History Pane, double-click on the module you want to re-edit.
3. The photo will open in the selected module with the settings and masks as they where

when you saved the image.
4. Adjust your settings or masks and press the Save and Close button.
5. Your image will be returned to Perfect Browse and you will see your changes applied.

Manage Smart Layers

If you want to turn off, or delete a Smart Layer, open the image in Perfect Layers and use the
Layers pane. Here you can edit, hide or delete modules from each Smart Layer in a Smart Photo.
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Perfect Browse (Mac OS X Only)

About Perfect Browse: Opens the about box, displays your version
number and activation code. (Help menu on Windows)
Preferences: Opens the preferences dialog. (Edit menu on Windows)
Quit Perfect Browse: Quits Perfect Browse.

 

 

File Menu

Browse Folder: Opens the browse dialog where you can select which
folder you would like to browse
Add Favorite: Opens the add favorite dialog that you can add a
favorite folder permanently to the Sources pane
Manage Extras: Opens the Extras Manager where you can import
and manage extras like Borders, Backgrounds, Textures and Presets.
Edit in...: Will launch the module with the file you have currently
selected  
Batch: Opens the Batch mode window

 

Edit Menu

Undo: Undoes the last file operation. This is only available the last thing
you did.
Redo: Redoes the undo operation. This is only available if the last thing
you did was an undo.
Select All: Selects all the images in the current folder
Select None: Deselects all the images in the current folder
Deselect: Deselects the current item
Copy: Copies the currently selected items
Paste: Pastes (copies) the items in the clipboard to the current location
Rename: Renames the selected file or folder
Delete: Moves the selected files and or folders to the trash
Add Subfolder: Adds a new empty subfolder inside the current folder

 

 

 

Menus
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View Menu

Bigger Thumbnails: Increases the size of the thumbnails
Smaller Thumbnails: Decreases the size of thumbnails
Sort: Sort by filename or date
View Mode: Select from thumbnail or Detail view. 
Preview Background Color: Change the preview background color
the thumbnails

 

 

Window Menu

Info: Opens and closes the Info pane.
Sources: Opens and closes the Sources pane.
Folders: Opens and closes the Folders pane. 
Recent: Opens and closes the Recent pane.
Show Browse Panel: Hides or reveals the entire Browse Panel (left
column of control panes).
Hide Panels: Hides or reveals both the left and the right Panels.
Full Screen Mode: Enters or exits full-screen mode

 

 

Help Menu

Search: Searches the menus (Mac OSX only).
Browse Online Help: Opens this html Help in your default web
browser.
Video Tutorials: Opens the online Video Tutorial in your default web
browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for  Updates: Checks with the onOne update server to see if
you are running the current version. If there is a newer version you will
be notified and be walked through the update process.
Deactivate: Opens the activation dialog. These are used to
deactivate your software for moving it to another computer or for a
return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to
the feedback page of the onOne website.
Help Improve onOne Products: Opens the Improve onOne
Products dialog.
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Keyboard Shortcuts

  Mac OSX  Windows

 Browse Folder  cmd b  ctl b

 Save As  cmd shift S  ctl shift S

 Print  cmd P  ctl P

 Exit  cmd q  ctl q

 Undo  cmd Z  ctl Z

 Redo  cmd shift Z  ctl shift Z

 Select All  cmd a  ctl a

 Select None  cmd d  ctl d

 Deselect  /  /

 Copy  cmd C  ctl C

 Paste  cmd V  ctl V

 Delete File  Delete  Delete

 Preferences  cmd ,  ctl ,

 Bigger Thumbnails + +

 Smaller Thumbnails  -  -

 Enable Filters  cmd L  ctl L

 Reset Filters  cmd shift L  ctl shift L

 Return to Thumbnail View  esc or g  esc or g

 Switch to Detail View  E E

 Color Label

 6 (Red)
 7 (Yellow)
 8 (Green)
 9 (Blue)
 0 (Purple)

 6 (Red)
 7 (Yellow)
 8 (Green)
 9 (Blue)
 0 (Purple) 

 Rating

 `(Clear Rating)
 1(Rate as 1 Star)
 2(Rate as 2 Stars)
 3(Rate as 3 Stars)
 4(Rate as 4 Stars)
 5(Rate as 5 Stars)

 `(Clear Rating)
 1(Rate as 1 Star)
 2(Rate as 2 Stars)
 3(Rate as 3 Stars)
 4(Rate as 4 Stars)
 5(Rate as 5 Stars)

 Like
 P(Like)
 X(Dislike)
 U(Clear)

 P(Like)
 X(Dislike)
 U(Clear)

 Rotate 90 Degrees CW  Cmd ]  ctl ]

 Rotage 90 Degrees CCW  Cmd [  ctl [

 Sources Navigation

 Up Arrow (up)
 Down Arrow (down)
 Right Arrow (open 
folder or Down)
 Left Arrow (close folder
or up)

 Up Arrow (up)
 Down Arrow (down)
 Right Arrow (open 
folder or Down)
 Left Arrow (close folder
or up)

 Thumbnail View Navigation

 Up Arrow (up)
 Down Arrow (down)
 Left Arrow (left)
 Right Arrow (right)
 Enter (image view or 
browse folder)
 Cmd Up Arrow (browse
up one level)

 Up Arrow (up)
 Down Arrow (down)
 Left Arrow (left)
 Right Arrow (right)
 Enter (image view or 
browse folder)
 Ctl Up Arrow (browse
up one level) 

 Favorites  cmd 1  ctl 1

 Sources  cmd 2  ctl 2

 Filters  cmd 3  ctl 3

 Recent  cmd 4  ctl 4

 Info  cmd 5  ctl 5

 Metadata  cmd 6  ctl 6

 Smart Photo History  cmd 7  ctl 7

 Show/Hide Browse Panel  cmd Left Arrow  ctl Left Arrow

 Show/Hide Photo Panel  cmd Right Arrow  ctl Right Arrow

 Hide Panels  tab  tab
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 Full Screen Mode  cmd ctl f  F11

 Keyboard Shortcuts  cmd shift k  ctl shift k

Perfect Browse  37

 

Perfect Browse



 

Perfect Batch

Perfect Batch is an engine for automating processes or applying presets that are available in each module.  It is ideal for
applying universal adjustments across a large number of images.  It can be launched from the Browse module or through Perfect
Layers. There are a number of reasons to use a Batch process.  

Some features of onOne Batch include:

Convert Files:  Select a source folder and create a new child folder and convert a large number of files to a new
desired format.
Resize Files:  Prepare files for printing, web or simply changing the dimension and/or resolution.
Apply Module Presets:  Use the factory presets or apply your own custom preset created from Perfect; Enhance,
Portrait, Effects, B&W and Resize.
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This getting started section will give you the basics of using Perfect Batch. If you have never used Perfect Batch before, this is a good place to start. You
might also try watching the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section, see the
"Using Perfect Batch" section instead. 

Pages in this Section
Batch Workspace
How to Access Batch

 

 

Getting Started
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Batch Workspace

To launch the Batch dialog box you must first be inside of either Perfect Layers or the Browse module.  Go to File > Batch to bring up the workspace dialog box.
 Within this dialog box you will be able to select a source, the preset(s) that will be applied, the destination and even place a watermark on the image.  

The Batch Dialog:
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How to Access Batch

 Launch the stand alone application of Perfect Photo Suite 8. The Batch module can be

accessed inside of either Browse or Perfect Layers. Go to File > Batch and this will

launch the batch dialogue. 

You can also select a group of images in the Browse module and select Perfect Batch

from the right-click contextual menu.

 

  

 You can also access Perfect Batch inside of Adobe Photoshop, Adobe Lightroom or

Apple Aperture.
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This section covers the complete use of Perfect Batch. It includes how to select files, adding a
module preset and saving to a destination. 

Pages in this Section
Selecting Files
Adding a Module
Destination Pane
Batch Presets

 

 

Using Perfect Batch
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The first step to beginning a Batch process is to select the Folder or Files.  The Source defines those Files or Folders. There are
two ways to choose the Source. 

 

Selected Items:  Inside of Browse you can simply select the the Folder or Files before going to File > Batch. The Source drop
down menu will read "Selected Items."

Folder: This option will require you to click the Choose button.  The Choose button presents you with a Finder or Windows
Explorer dialogue where you will navigate to and select a Folder.  After you have a folder selected the description will appear next
to Folder. 

Include SubFolders: If this box is checked the Batch will also process any that reside within subfolders of the parent Folder you
have selected.  

 

Selecting Files
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After you select a source you choose the module(s) you wish to use for the Batch process.  

Each Module has its own pane that contains a choice of Type, Category and Preset.  

If you are not familiar with Presets we recommend you review the Preset pages for each module to better understand how this works.

Type:  Choose between either a Factory
Preset or a Personal Preset you have
created or installed.
Category:  Select the category in which
the Preset lives.
Preset:  Pick the preset you want to
apply during the Batch.
Pause on the first image: 
When checked the first image is
processed and the batch will pause so
you can evaluate.  

The Perfect Resize module includes additional
options for output. You can apply a preset, either
factory supplied or a user saved preset, or you
can enter the size you desire. If you manually
enter a size you can select to fit in a specified size
(width & height) or to scale the long or short side
of the images to a specified dimension. This can be
good for resizing images for web or for proofs.

 

 

Adding a Module
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The Watermark module allows you to add an
overlay to the image, typically used for your logo,
signature or copyright.  

File:  Click the Choose button to select
the file you wish to use as your
watermark.
Size:  This slider controls the size of the
watermark file.  
Inset:  This will determine the percentage
in which the file is inset from the edge.
Opacity:  This sets the opacity of the
watermark.
Location:  This grid sets the location of
the watermark.  Click on the square of the
location you desire.
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Destination Pane

46  Perfect Batch

Perfect Browse



The destination pane is the last step in the Batch
workflow.  This determines where the processed
files are saved, how they are named, the file type
and additional options. 

Save To: This drop down
menu includes three options; Round
Trip, Current Location or Folder.
Roundtrip saves the file over the
original and uses the same file
format, bit-depth, color space and
name. Naturally all the additional
options will be grayed when this
option is selected. Current
Location will write the file to the
same location as the original file.
The Folder option will allow you to
choose a new location the files will
be saved to. Click the Choose
button to select the new location.  
Folder: The Folder will list the path
the file is going to be saved. This
line will only be seen when the
Folder option is selected under
Save To.
Put in Subfolder:  When checked
this will create a subfolder in the
destination and you may name the
subfolder in the field on the right. 
Match Source Folders:  When
checked this option will match the
hierarchy of the source folder.
Existing Files:  This drop down
determines what will happen if
there is a file name conflict.
Overwrite without warning or
Prevent overwrite. If Prevent
overwrite is chosen the word 'copy'
will be added to the file(s).  
File Type:  This drop down
determines the file format or
extension.  The choices include;
 Same as Source, Photoshop,
Photoshop Large Document, JPEG,
TIFF and PNG. The quality slider is
only available for JPEG.
Color Space:  This drop down will
include all the available color
profiles installed on your system.  
Naming Element:  This option
may be used to determine the file
name. The options include;
 Current Name, Text and Number.
 The field to the right allows you to
enter a custom name.  The plus
and minus icons will allow you to
add or remove naming elements.
 Current Name will use the source
name without the file extension.
Text is used for assigning a custom
text string.  Number creates an
automatically incremented number,
starting with the number input in
the field. 
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Batch Presets

Presets for the Batch settings can be saved and used again.  Presets will remember all of the settings and details selected on the right, in the Batch
dialogue.  

 

Saving Presets:  To save a preset click the "+" icon at the lower left.  This opens a preset dialogue
where you define the name, category, creator and description.  
Using Presets:  To use a preset simply double click on the name.  This will load the preset settings in
the batch dialogue.
Deleting Presets:  To delete a preset select the item and click the "-" icon at the bottom left. 
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